IS 312  Spring 2012 - PROJECT #3 (Due 5/2)

Credit Default Swap Claims

Decision Support Using Access and Excel

PREVIEW

A large pension fund invested in triple-A rated bonds and used your firm to insure the payment of the bonds’ principal and interest. The bonds’ collateral is a group of residential mortgages, and now the pension fund might want to collect on the insurance. In this case, you will use Access and Excel to analyze the quality of the collateral and determine whether your firm must pay the insurance claim.

BACKGROUND

Your investment banking firm is always looking for profitable investments. In recent years, your firm has issued credit default swaps, which are a form of investment insurance, to increase revenue and improve the bottom line.

Swaps, however, now look risky to your firm. To understand why, you need to understand the situation and the following groups:

• Home owners — People generally need to take out a mortgage when they buy a house. A mortgage is a loan that must be repaid over a period of time (usually 15 or 30 years). For example, a person might buy a house for $200,000, make a $20,000 down payment, and take out a 15-year mortgage at their local bank to pay for the balance. The person now owns the house but owes $180,000 to the bank. Every month for 15 years, the person makes a payment to the bank. The payment is partly interest and partly loan principal. At the end of 15 years, the loan is paid off.

• Local bank — To a bank, a loan is a productive asset that earns interest income as payments are made over 15 or 30 years. However, sometimes a bank would rather realize the full value of the loan immediately rather than over time. For instance, banks must “service” their loans by keeping track of payments made and how much customers owe, and some banks would rather not be bothered with that burden. Also, a bank might have an immediate use for the full cash value of a loan. In that case, the mortgage’s promissory note — which is a negotiable instrument — can be sold for any amount the market will bear. To use the previous example, the $180,000 mortgage could be sold to an investor who wants a 15-year stream of payments.

• Structured investment vehicle (SIV) — An SIV is a company that buys mortgages from local banks. The mortgages become the SIV’s assets, so the monthly payments flow to the SIV. The SIV gets the cash to buy mortgages by issuing a bond called a collateralized debt obligation (CDO), which is bought by a wealthy investor looking for an investment that pays interest. For example, an SIV might buy 200 fifteen-year mortgages from banks in the region. The total value of all the loans could be $50,000,000 and the average interest rate could be 6%. Simultaneously, the SIV issues a 15-year bond to a wealthy investor that pays a 5% interest. Every month, the 200 home owners send their payments to the SIV, and the SIV sends a payment to the wealthy investor to cover the bond’s monthly principal and interest. The difference in rates (here, 6% versus 5%) is what allows the SIV to prosper. Note that if home owners fail to make
their monthly payments, the SIV might have trouble making its payments to the wealthy investor. SIV payments might be late as it waits for sufficient cash to flow in.

- Investors—The wealthy investor that buys the SIV’s bond could be a pension fund, a mutual fund, an investment bank, some other finance company, or even an individual. The 200 home mortgages from the previous example are the bond’s collateral. If the SIV defaults (fails to make payments), the investor can foreclose on the homes. The bond is called a collateralized debt obligation because the obligation is backed up by collateral. Investors do not want to foreclose on houses, however, so they seek two other forms of protection: the blessing of a credit rating agency and insurance in the form of a credit default swap.

- Credit rating agency — The SIV will have a credit rating agency review its mortgage deals. If the rating agency sees problems, it will issue a poor rating. If the agency sees no problems, it issues a good rating, which gives the investor confidence that SIV payments will be made.

- Insurer — The investor is willing to pay a fee for insurance against the possibility that the SIV will default on the bond’s payments. This fee is revenue to the insurer. If the SIV’s payments are made, the insurer has no expense; but if a default occurs, the insurer must send a check to the investor for some or all of the bond’s full value. The insurance instrument is called a credit default swap. The insuring company can be an actual insurance company, an investment bank, or another kind of financial firm.

In fact, this kind of complex transaction has been common in recent years. You work for an investment bank that has earned tremendous fees for credit default swaps in the past few years. Your firm has an ongoing relationship with an SIV called Desert Storm Investments and a pension fund named Midwest Wealth Management.

Three years ago, Desert Storm worked with a number of Western mortgage banks to put together a CDO (code-named “Curly”). Pacific Surf Analytics, a well-known credit rating agency, gave its highest rating (AAA) to Curly’s collateral, which consisted of 200 residential home mortgages. The bond was sold to Midwest Wealth Management, a large pension fund that paid your company $2 million for the credit default swap. Desert Storm has faithfully made monthly payments on Curly to Midwest.

Two years ago, Desert Storm again worked with its mortgage banks to put together another CDO (code-named “Larry”). Pacific Surf Analytics gave its highest rating to Larry’s collateral, which also consisted of residential home mortgages. The bond was sold to Midwest Wealth Management, which paid your company $2 million for another credit default swap. Desert Storm has been late making monthly payments on Larry to Midwest.

One year ago, Desert Storm again worked with its mortgage banks to create another CDO (code-named “Moe”). Pacific Surf Analytics gave its highest rating to Moe’s collateral, which was another batch of residential home mortgages. The bond was sold to Midwest Wealth Management, which paid your company $2 million for another credit default swap. Desert Storm has been late making monthly payments on Moe to Midwest.

You have recently been promoted to an analyst’s position in the credit default unit at your firm. You have no experience with this kind of investment product and the related analysis, so
you investigate how your predecessor handled credit default swaps. You learn two things that make you uneasy:

1. She did not actually investigate the details of the CDO’s underlying mortgages, but assumed that the credit agency Pacific Surf Analytics did the investigation. In fact, your predecessor did not even have a list of the home mortgages that backed up the insured CDOs.

2. Your contact at Pacific Surf Analytics says that her company does not look at each mortgage in the CDO. She said, “A mortgage contract has a lot of pages. There are hundreds of mortgages in a CDO. How can I read all that? Do you think I have time to investigate each home owner’s credit scores?”

You learn that Pacific Surf Analytics assesses credit worthiness using a computer model that includes some high-level macroeconomic data for the region. Your contact says that the model generally predicts good results for mortgage-backed investments in your region.

Your contact at Pacific Surf Analytics explains some of the basics of real estate mortgage credit analysis. Assume, she says, that a man puts $20,000 down on a $200,000 house, taking a 7% mortgage for $180,000. Monthly payments are $1,618. After a few years, the man has some economic problems and has trouble making the monthly payment. However, there are three reasons to be optimistic. (1) In most years, U. S. real estate values have gone up, sometimes dramatically. Assume that the market value of the man’s house is now $250,000, an increase of $50,000 from the purchase price. The man can borrow some percentage of that increase using a “home equity” loan; the collateral is the value of the house, which now covers both the first and second mortgages. (2) Perhaps interest rates have fallen, say to 5%. The man can now refinance his $180,000 loan so that his monthly payment is lower and more affordable. (3) Banks do not foreclose after a couple of missed payments. Therefore, the man may be in arrears, but as times improve he probably will make payments again.

In summary, your contact says that the credit rating agency is very comfortable with CDOs that have real estate mortgage collateral. However, you know that mortgage rates have not changed much in the last few years, and refinancings are not as common as they used to be. Also, you know that real estate values have not been skyrocketing lately.

Furthermore, you’ve read your company’s credit default insurance contract. The investor can claim the insurance when the value of the collateral has been “significantly impaired.” In other words, the investor does not have to wait until the SIV’s monthly payments dry up and 200 homes are foreclosed. The contract says that the investor can file an insurance claim if SIV payments are late. The claim would have to be paid if more than 75% of home owners are two or more months in arrears with their payments to the SIV. Such conditions would demonstrate significant impairment according to the contract.

Of course, the investor does not know which home owners are late and which are not. However, SIV payments to the investor have been late on the Larry and Moe CDOs. Are home owners not making their mortgage payments to the SIV? You are worried that the investor will lose patience and file claims on the two CDOs under the terms of your credit default swaps. Each CDO is a $35 million bond!
You ask Desert Storm to give you paperwork on each loan that supports the Curly, Larry, and Moe CDOs. Your assistant laboriously enters the data into an Access database file called Loans.accdb. The database includes three tables; the table Year1Data contains the records for the Curly CDO, which was formed in the first year of Desert Storm’s relationship with the investor Midwest Wealth. Figure 1 shows the first few of the table’s 200 records.

Figure 1  Data for Curly CDO’s loans

Field definitions are as follows:

- **Loan Number** — a unique number assigned to each loan. This is the primary key field.
- **Loan Value** — The amount borrowed to buy the house.
- **Appraised** — The selling price of the house when it was purchased. This price is assumed to be the appraised value at the time of purchase. For example, the house in loan 1001 was sold for $110,000. The new owner paid a $27,500 down payment and borrowed $82,500.
- **Current Value** — The current market value of the house at the time you are doing the analysis. Notice that the value of the house in loan 1001 has declined in the three years under review.
- **No Doc** — Lenders usually require an applicant to document the loan application thoroughly. For example, prospective borrowers must show that they have a job and a certain income. Lenders will require borrowers to submit documents such as tax returns and pay stubs to prove their claims. However, in recent years some lenders have just taken the applicant’s word for his/her claims. In other words, they have made loans without requiring documentation; such loans are called “No Doc” loans. Loan 1001 was not a No Doc loan — the bank did require the applicant to prove claims about a job and income (If the loan had been a No Doc loan, the field’s value would have been YES).
- **FICO** — The loan applicant’s FICO score at the time of the loan. A FICO score is a measure of personal credit worthiness. FICO scores range from 300 to 850. The higher the score is, the better.
- **In Arrears** — This value shows whether the owner is up to date in monthly mortgage payments. A value of NO means the borrower is up to date. A value of YES means that the borrower is two or more mortgage payments behind. Note that being in arrears does not mean that the house is in foreclosure.
The table Year2Data contains the records for the Larry CDO, which was formed in the second year of Desert Storm’s relationship with Midwest Wealth. Figure 2 shows the first few of the table’s 200 records. The field definitions are the same as those in Figure 1.

![Year2Data](image1)

**Figure 2** Data for Larry CDO’s loans

The table Year3Data contains the records for the Moe CDO, which was formed in the third year of Desert Storm’s relationship with Midwest Wealth. Figure 3 shows the first few of the table’s 200 records. The field definitions are the same as those in Figure 1.

![Year3Data](image2)

**Figure 3** Data for Moe CDO’s loans

You need to use Access and Excel to see whether payments on the credit default swaps would be required if the investor filed a claim.

**TASK 1: MAKING QUERIES IN ACCESS**

To complete this task, you will create three queries.

**Year 1 Query**

Create a query that lists all data for the Curly CDO’s loans and computes two ratios for each record: the loan value to appraised value ratio and the loan value to current market value ratio. Your output should look like that in Figure 4 (only the first few of the 200 records are shown). Name the query *Year1Query*.

The Loan to Appraised ratio shows the down payment that was made on the house. For example, if the ratio is less than 0.90, a down payment was made for more than 10% of the value. Format the ratio’s fields to have 3 decimal places.
Create a query that lists all data for the Larry CDO’s loans and computes the same two ratios for the Larry CDO’s loans as the ratios for the Year 1 query. Name the query Year2Query. Next, create a query that lists all data for the Moe CDO’s loans and computes the same two ratios for the loans. Name the query Year3Query. The format of the output is the same as in the Year 1 query.

When you finish the queries, save and close the Loans.accdb file.

TASK 2: USING EXCEL FOR DECISION SUPPORT

To complete this task, you will import your three Access queries into Excel worksheets and then develop information about the possible insurance claim.

Importing Queries

Open a new workbook file in Excel and save it as Loans.xlsx. Then import the Year1Query data into Excel. Rename the worksheet Year1.

The data will come into Excel as an Excel data table. You should change the table to a regular data range at this point by clicking a cell in the table, clicking the Design tab, and selecting Convert to Range in the Tools group. Year 1 data should look like Figure 5. Note that you may need to format the two loan ratio columns to three decimal places.

Further Calculations
You want to know if a loan is a so-called “subprime” loan and if a loan is “under water.” A loan is subprime if the borrower’s FICO score was less than or equal to 620 and the loan to appraised ratio is greater than or equal to 90%. In other words, the down payment was less than or equal to 10%, meaning that the borrower does not have good credit and did not make a good down payment. An under-water loan is one in which the initial loan value is greater than the current market value. An under-water loan has a loan to current ratio greater than 1.

In the Year1 sheet, create column headings for SubPrime and Underwater, and then enter formulas to compute these values. The top part of the Year1 worksheet would look like Figure 6. Perform the same calculations in sheets Year2 and Year3.

![Figure 6](image)

**Figure 6** Year1 sheet with subprime and under-water calculations

You now want to convert the data ranges back to data tables. To do so, select the entire data range, including the header line. In the Home tab Styles group, select Format as Table. Pick a light style. The Design tab will be activated automatically. In the Table Style Options group, select Total Row. Repeat these instructions for each of the three worksheets.

**Using Data Tables and Pivot Tables to Gather Data**

You now want to use the Excel data tables and pivot tables to gather data.

**Data Table Analysis**

Open a blank Microsoft Word document and create three tables that look like the three comparison tables shown in Figures 7, 8, and 9. Use your Excel data to complete the entries for these comparison tables. **Note that these three figures are Word tables, not Excel data tables or Excel pivot tables.** You will include the comparison tables in your memorandum at the end of the project.

Use the Total Row in the Excel data tables to gather the data required and enter it in Comparison Table 1 (Figure 7). **Format your data accordingly.**

<table>
<thead>
<tr>
<th></th>
<th>Year 1 Loans</th>
<th>Year 2 Loans</th>
<th>Year 3 Loans</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average loan value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average appraised value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average current value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average FICO score</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average loan to appraised ratio</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average loan to current ratio</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Figure 7  **Comparison Table 1: Average Data**

Use the column filters and the Total Row in the Excel data tables to gather the data required and enter it in Comparison Table 2 (Figure 8). Format your data accordingly.

<table>
<thead>
<tr>
<th></th>
<th>Year 1 Loans</th>
<th>Year 2 Loans</th>
<th>Year 3 Loans</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count of No Doc loans</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count of loans in arrears</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count of subprime loans</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count of under-water loans</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 8  **Comparison Table 2: Count Data**

In each year, the SIV selected 200 loans to back up the CDO. After looking at the averages and the counts in the tables, you should consider the following questions:

- Did the SIV select different kinds of loans (or borrowers) in the three years? In other words, did the real estate market change so that different loans were selected?
- Does it appear that lenders changed lending standards so that less capable payers were given loans?
- Does it appear that market values have increased enough to allow home owners to borrow under home equity loans?
- For each CDO, what percentage of loans is in arrears?

Use the column filters and the Total Row in the Excel data tables to gather the data required and enter it in Comparison Table 3 (Figure 9). **DATA IN THIS TABLE IS LIMITED TO LOANS THAT ARE IN ARREARS ONLY.**

<table>
<thead>
<tr>
<th></th>
<th>Year 1 Loans</th>
<th>Year 2 Loans</th>
<th>Year 3 Loans</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count of loans in arrears</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average loan to appraised ratio</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average loan to current ratio</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count of subprime loans</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count of under-water loans</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count of loans that are both subprime and under-water</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 9  **Comparison Table 3: Data for loans in arrears**

Note that the first row in Figure 9, Count of loans in arrears, should agree with the same count in Figure 8. Note also that you can set a double filter or a triple filter in the top line of an
Excel data table. For example, in the header line of Figure 6, first set *In Arrears* to **YES** and then set additional filter(s) (e.g., set *SubPrime* to **YES**). Then use the Total Row to gather data.

While looking at the data, you should try to see what borrower characteristics seem to correlate with payment slowness. Are loans that are in arrears likely to be subprime loans? Under-water loans? Both? Does a low down payment predict slow pay?

**Pivot Table Analysis**

In each worksheet, create a pivot table. The pivot table should show the average ratio of loan to appraised value, the average ratio of loan to current value, and the average FICO score. Do not include the Total Row in your input data range. You should tell Excel to put each pivot table in the same worksheet where the data is, respectively, with the upper-left corner at A205. Shown in Figure 10 is a sample of how your pivot table would look like (the actual numbers would be different). Change the headings and formatting to match what’s shown in the sample.

![Figure 10 - A Sample Pivot Table](image)

Examine the results and consider the following questions:

1. Does the size of the down payment predict very well whether a borrower will go into arrears?
2. Does the ratio of loan to current value predict very well whether a borrower will go into arrears?
3. Does the borrower’s FICO score predict very well whether a borrower will go into arrears?
4. Which of the three measures above seems to be the best predictor of whether a borrower will go into arrears?

**TASK 3: USE ACCESS QUERIES TO VERIFY YOUR PIVOT TABLE RESULTS**

To complete this task, you will use Access queries to independently verify the results of your three Excel pivot tables. First, you need to export your data back to Access. Follow the procedure below to prepare your data and send it back to Access:

2. Turn off all column filters in worksheets **Year1**, **Year2**, and **Year3**, so that all 200 loans in each worksheet are shown. Delete the Total Row.

3. Copy the cell range Year1!A1:K201 to a new worksheet and name it CopyOfYear1, copy the cell range Year2!A1:K201 to a new worksheet and name it CopyOfYear2, and copy the cell range Year3!A1:K201 to a new worksheet and name it CopyOfYear3.

4. Save and close **Loans.xlsx**.

5. Open the **Loan.accdb** database file that you started this project with.

6. Click the **External Data** tab and select **Excel** from the **Import** group on the Ribbon.

7. Click **Browse** to locate and open the Excel workbook file (**Loan.xlsx**) you have been working on.

8. Make sure the radio button next to **Import the source data into a new table in the current database** is selected. Click **OK**.

9. Select the worksheet, **CopyOfYear1**, and click **Next**.

10. Check the box next to “**First Row Contains Column Headings**,” and click **Next** twice.

11. Select **Choose my own primary key** (Loan Number), click **Finish**, and then **Close**.

12. Repeat steps 6-11 to import **CopyOfYear2** and **CopyOfYear3** into Access.

Now use each of the three imported tables to create a summary (aggregate) query that will reproduce the same statistics as those you generated using Excel pivot tables. Shown below in Figure 11 is the sample result of such a summary query.

![Summary Query](image)

**Figure 11   A Sample Summary Query**

**TASK 4: DOCUMENTING FINDINGS IN A MEMORANDUM**

To complete this task, you will write a memorandum to document your findings and recommendations. You should describe the business situation briefly. Summarize the nature of the collateral in the three years and indicate how things have changed. **You should create Word tables like those in Figures 7, 8, and 9 as an addendum to your memo. You should also include a copy of the three pivot tables in your memo, also as an addendum.**

You should be able to state whether your company will be liable for a claim under any of the three credit default swaps you have written with the investor.

Note that a successful claim would be for the amount of the investor’s bond, which would be about the same as the total of the initial loans in the CDO’s collateral. If you are close to being liable for a claim under a credit default swap and you think that the situation may worsen as time goes on (in other words, more borrowers will go into arrears), answer the following
questions: Should your company try to help the home borrowers make payments to the SIV? If so, what sort of help is needed, and how much? Would a better plan be to preemptively settle with the investor for a lesser amount (say, $10 million) to get out of the insurance contract?

In your memo, observe the following requirements:

• It should have proper headings such as Date, To, From, and Subject. You can address the memorandum to your manager.

• Briefly outline the situation. However, you need not provide much background about the business — you can assume that readers are familiar with the real estate business, CDOs, and credit default swaps.

• Answer the preceding questions (see pages 8 and 9) in the body of the memo.

• Support your arguments by referring to important results in the three comparison tables (see Figures 7, 8, and 9) and the three pivot tables.

**SUBMISSION REQUIREMENTS**

A. Electronic:

At the completion of your project, send me an email message with your Access database file and Excel Workbook file attached (Do NOT attach the memo). Rename the files so they have the following format: lastname-firstname.accdb and lastname-firstname.xlsx, respectively, using one of your group members’ names. Include class time and all member names in your message.

B. Hardcopy:

Download and print p3-grading-sheet. Fill out the name/time part. Print your memo. Staple the grading sheet on top of the memo.

No late project will be accepted. Turn in your incomplete work for partial credit.